Trouble-Shooting Coordinate System Problems

Written by Barbara M. Parmenter. Revised for 10.7.1 on 7/23/19

OVERVIEW OF THE EXERCISE ................................................................. 1
COPYING THE MAP PROJECTION EXERCISE FOLDER TO YOUR H: DRIVE OR DESKTOP ......................................................... 2
WHAT IS THE COORDINATE SYSTEM AND PROJECTION OF THIS DATA SET? ........................................................................ 3
WHAT’S THE COORDINATE SYSTEM OF MY DATA FRAME? ............................................................. 3
YOUR TURN – FIND THE COORDINATE SYSTEM INFORMATION ........................................................................... 4
SETTING AN APPROPRIATE COORDINATE SYSTEM FOR MAPPING .......................................................... 5
YOUR TURN – SET AN APPROPRIATE COORDINATE SYSTEM ........................................................................ 6
HEY, WHERE’S MY DATA LAYER? – TROUBLESHOOTING MISSING/INCORRECT SPATIAL REFERENCES ...................................... 6
SETTING UP FOR SPATIAL ANALYSIS – PROJECTING YOUR DATA ........................................................................ 10

Skills covered in this Tutorial Include:

- Knowing where to look in ArcGIS to get information about a data set’s coordinate system
- Knowing how to change the coordinate system of a data frame in ArcMap
- Understanding how to select an appropriate coordinate system for a given area
- Understanding some of the problems that might occur in GIS due to map projection and coordinate system issues

Overview of the exercise

This is an exercise designed to be done in the Tufts Data Lab (or at home if you have copied the exercise data folder). It will familiarize students who have been introduced to coordinate system concepts with the issues they may face in real-world situations using ArcGIS.

A solid understanding of coordinate systems is critical for GIS users. Selecting an appropriate coordinate system is necessary for good visualization. The accuracy of spatial queries, overlays, and calculations (e.g., area and perimeter) rely on accurate coordinate system and projection choices. The issues may manifest themselves as errors that preclude completion of a certain query or calculation, or errors in the results of a query. For example, you cannot calculate the area of polygons for a data set that is only in a Geographic Coordinate System (GCS), but not projected. In addition, spatial queries in a GCS coordinate system may not perform properly. If you are using an inappropriate Projected Coordinate System, your selections based on spatial relationships (“show me all the buildings within 2 miles of a geologic fault line”) and your area/perimeter/length calculations can be completed, but they may have significant errors.

The bottom line is:

- You need to be aware of what the coordinate system is for each of your data sets.
- You should generally work within an appropriate projected coordinate system for your area of interest (NOT a Geographic Coordinate System!)
When performing spatial analysis (where spatial relationships matter—e.g., spatial overlays, proximity functions, and area/length/perimeter calculations), all the data sets involved need to be in the SAME projected coordinate system.

You need to make sure your DATA FRAME is also in the same projection. If your data is projected, but your Data Frame is not, the data will still look and perform incorrectly.

Many, if not most, of the most common problems encountered by GIS users turn out to be related to coordinate system issues. This tip sheet takes you through several common issues you’ll encounter in GIS that have to do with coordinate systems.

More information about coordinate systems is available through ArcGIS 10.7.1 Online Help in their Guidebook for Map Projections.

Copying the Map Projection Exercise Folder to your H: drive or Desktop

Before you begin, you need to have your own, write-able copy of the exercise data which we will copy from the S drive. If you need guidance for mapping network drives to these servers, please see Accessing Network Drives.

1. **Copy** the Map Projection Exercise folder from S:\Tutorials & Tip Sheets\Tufts\Tutorial Data to your H: drive. Copy and paste the entire Map Projection Exercise folder, not the whole Tutorial Data folder itself.

2. Once you have it in your H: drive, right-click on the Map Projection Exercise folder and choose **Properties → General tab**.

3. Uncheck the Read-Only box. A “Confirm Attribute Changes” box may pop up. Make sure that “apply changes to this folder, subfolders, and files” is selected, then press OK. Don’t worry if your Archive isn’t checked— it’s not important for now.

4. In your H drive, open the Map Projection Exercise folder and double-click the following map file: *map_projection_exercise01.mxd* – this will start ArcMap with the data preloaded.
What is the Coordinate System and Projection of this Data Set?

It’s critical that you know the **Geographic Coordinate System** of each of the **data sets** you are using.

Each data set is in a specific coordinate system. Coordinate systems are required information needed to create the dataset – without this information, the data wouldn’t know where to show up in ArcMap. Most professionally produced GIS data sets will have a defined **geographic coordinate system**, but may not have a defined **projection**. You can find out what a data set’s coordinate system is in the properties window for each individual layer.

Follow these steps to figure out what **Geographic Coordinate System** and **Projection** a dataset or layer is using.

1. Right-click on the **Towns_Poly** layer in the **Table of Contents** and choose **Properties**, then click the **Source** tab. The **Source Tab** contains lots of important information about the coordinate system, projection, units and location of where your data is saved.

2. First, you should see information about where the data set is located and the geometry type. Then, you should see information about the spatial reference. **IF** the data is projected, you will **first** see the **Projected Coordinate System** information, which typically uses meters or feet as the unit of measurement.

3. Scroll down farther to see the **Geographic Coordinate System** information, which uses latitude and longitude (decimal degrees) as the unit of measurement.

Note: All **Projected data has a Geographic Coordinate System**, but data that is **just** in a **Geographic Coordinate System** does **NOT** necessarily have a projection. Confusing, we know!

**Question 1**: Is this layer projected? If so, what is the projection name, projection type, units, and what is the geographic coordinate system?

What’s the Coordinate System of my **Data Frame**?

It’s also critical for you to know the coordinate system of the **data frame** you are working with in ArcMap.

The data frame **ALWAYS** takes on the coordinate system information (projection or not) of the **first data set you add**. Any layers you add after that will “project on the fly” to match the data frame. This means if you pull in a dataset that has different coordinate information than the data frame; the data will act as if it’s in whatever coordinate system your DATA FRAME is set to.

So, if you know you have data in a projection you want to use, you should pull this layer into your ArcMap session first so you KNOW your Data Frame is in the correct projection!! If the first data set you add is **missing a spatial reference**, then your Data Frame’s coordinate system will also be **undefined**. This is **bad**!

Of course, you can always change the data frame coordinate system if you need to.
You can view the coordinate system of your data frame in one of two ways in ArcMap:

1. On the main menu, click View → Data Frame Properties and then click on the Coordinate System tab.
2. Or, right-click on Layers in the Table of Contents column (or whatever your Data Frame is called), then click on Properties, and then the Coordinate System tab

Your Turn – Find the Coordinate System Information

- **Question 2:** What is the coordinate system information of the Data frame? Is it projected?

  1. For the data layers within the red box below, write down the name of the Geographic Coordinate System, AND if given, write down the Projection Information, including NAME, TYPE of PROJECTION and the UNITs:

        | Cities |
        |--------|
        | Cities |
        | Simple |

        | Nantucket (Town of Nantucket GIS) |
        | hydro |

        | World countries |

For Example: For Cities, you would write down the highlighted information below:

This dataset is NOT in a projection! It only provides Geographic Coordinate System information.

For Towns_Poly, you would write down the information highlighted in yellow below in addition to the GCS info.

This dataset IS projected and uses meters as its unit of measurement!
Tufts Data Lab

- **Question 3**: Out of the list, which datasets are projected and which are not?
- **Question 4**: Are all the projected data layers in the same projection?
- **Question 5**: Is the *World Countries* data sets projected?
- **Question 6**: Why do you think the Maine Counties data set isn’t using a State Plane coordinate system? (Hint: in ArcMap, turn on the *State Plane Zones NAD83* layer and zoom in to Maine. And remember that State Plane zones are for local mapping.)

### Setting an Appropriate Coordinate System for Mapping

We’ve discussed in class the different types of coordinate systems and projections, and when one is more appropriate than another. You can also review the ArcGIS 10.7 web help section for [Supported Map Projections](https://desktop.arcgis.com/en/arcmap/latest/webhelp/map-projections.html) for advice.

In this ArcMap session, we have three coordinate system grids pulled in to help us visualize the difference:

- **A 10 x 10 Degree Graticule** which shows latitude and longitude (in 10 degree blocks and decimal degrees units).
- **UTM Zones** of the world (zone labels are at the top)
- **State Plane Zones NAD 83** of the US (zone names will appear if you zoom in below 1:20,000,000 scale).

Take a look at the UTM and State Plane Zones (zoom in to a state or group of states to see the State Plane zones more clearly)

- The **UTM Zones Coordinate System** was developed to facilitate accurate mapping for both local and regional mapping. They are especially useful for regions that extend north/south.
- The various **State Plane Coordinate Systems** were developed primarily to facilitate local mapping (at the city or metropolitan scale).
- The **10x10 Degree Graticule Geographic Coordinate System** is not a projected coordinate system—it is a useful way to distribute data for large areas (e.g., the US or the World,) but you should always choose a projected coordinate system when using this data in a map or for spatial analysis.

To create a good map with an appropriate projection, you can change the Data Frame’s coordinate system by going to the Data Frame’s Properties → Coordinate System tab (remember how to get there?). You can then navigate to a projected coordinate system of your choice, depending on where you are working.

We have talked about the State Plane and UTM coordinate systems in class. Note there are other coordinate systems and map projections that ArcGIS makes available. For example, to make a map of the continent of Africa, you might want to choose a map projection specifically designed for that—recall that **Conformal** means the map projection retains angular relationships and the accurate shapes of features as much as possible, and that **Equal Area** means that the projection retains accurate area and relative sizes and of features as much as possible:
Your Turn – Set an Appropriate Coordinate System

Based on what you have learned in class, and using the UTM Zones and State Plane Zones grids to guide you where appropriate, choose four of the following areas and set an appropriate coordinate system for the data frame for each in turn.

1. To do so, click on View → Data Frame Properties, then the Coordinate System tab.
2. Choose either from the Projected Coordinate Systems folder or if one of the layers on the map has what you want, you can choose from the Layers folder. When you see choices, look for NAD 1983 and WGS 1984 as the best options North American locations (NAD 1983) or the rest of the world (WGS 1984) respectively.

Question 7: Pick four locations from the following list and set the correction projection through the Data Frame properties for each. For each location you choose, take a screen shot of the ArcMap Session with the projection set (and zoomed into the area of interest) and write down the projection information (projected coordinate system name, Projection type, the Linear Unit).

- The Florida Panhandle
- Washington, DC
- Nantucket
- Chicago
- San Francisco metropolitan region
- All of California
- Port au Prince, Haiti
- Maine
- Honduras
- South Korea
- Montana
- Canada
- Europe
- New Delhi, India
- Somerville, Massachusetts
- All of Brazil
- A continent of your choice, for purposes of showing the most accurate shape of features
- A continent of your choice, for purposes of showing the most accurate area of feature

Hey, where’s my data layer? – Troubleshooting missing/incorrect spatial references

In this section you will learn how to handle data sets that are missing a spatial reference or that have the wrong spatial reference.

1. In ArcMap, choose File → Open and navigate to the map_projection_exercise_02.mxd map file in your H drive (you don’t need to save this current map session).

We are zoomed into Boston, with the MassGIS Towns poly layer and the Boston Redevelopment Authority’s Planning District layer (Boston Neighborhoods90).

- Question 8: What are the coordinate system and linear units of each of these layers? Write them down.
- Question 9: What is the coordinate system and linear units of the data frame? Write it down.

It’s fairly common that city planning departments use the “feet” version of their area’s State Plane coordinate system, while MassGIS uses the “meter” version.

The major point here is that both data sets appear together in the correct location even though they are in different coordinate systems (one based on feet and the other on meters). This works because ArcGIS knows what those coordinate systems are, making them both appear to be in the data frame’s State Plane meter projection!

Occasionally, a dataset’s coordinate system has NOT been defined explicitly by its creator. Every GIS data set is in some coordinate system, and the ArcGIS software sees these coordinates. But unless the data creator has explicitly recorded
the coordinate system of the data, the software has no way of knowing what system these coordinates represent, so no way of knowing where in the world they may be.

When you try to add a data layer that has no defined coordinate system to your ArcMap session, you’ll get an error message like this:

![Unknown Spatial Reference]

The data layer might draw, but it may or may not draw in the right place! And you never want to use data that has a missing spatial reference. This will only lead to many many problems!

Adding data from the City of Newton

1. Add the building footprint layer from the City of Newton (H: \Map Projection Exercise\Newton_Data\bldgfoot.shp)
   
   - **Question 10**: What happened when you added the buildings layer?

2. Right click on bldgfoot and press zoom to layer.
   
   - **Question 11**: Where has the data been placed? What else is at this location?

Finding the lost data

1. Right-click on building footprints and choose Zoom to Layer. Do you have any idea where this data is located?

2. Click on the full extent button

3. Now, can you see where the Newton data layers were placed? This is nowhere near the City of Newton.

Correcting the problem

We asked the City of Newton what coordinate system they use when they make their data, and they told us that they use **Massachusetts State Plane Mainland, NAD 83, with linear units of FEET**.

- The building footprint data set’s coordinate system is missing a spatial reference and needs to be defined!

The correct coordinate system for this layer (known through our investigation) is Massachusetts State Plane Mainland, NAD 83, with linear units of FEET.

Defining a Projection

Let’s first define the projection for the data set missing a spatial reference (bldgfoot). This process will create a small projection file (.prj) that will then reside with the data set.

1. In ArcMap, click on the red Arc Toolbox icon

3. Click on *Show Help* at the bottom of the tool. This tool assigns a projection to a dataset with **MISSING** spatial information. It SHOULD NOT BE used to change a projection of an already projected layer.

4. For the *Input Dataset* click on the black arrow to select **BLDGFOOT**
5. Follow the graphic below to select a new coordinate system:

6. Expand State Plane → NAD 1983 (US Feet). Choose the Massachusetts choice as you see below (don’t choose Massachusetts ISL – that’s for the Islands!):

7. Click OK and OK again to complete the task. The process will take a minute or so then you will get a pop-up message that it has completed.

8. Now, right click on the bldgfoot layer and press zoom to layer. Do the Newton building footprints show up in the right place? Click on the redraw icon at the bottom of the map if necessary.

We have now assigned the layer (which was missing ANY spatial information) the correct State Plane coordinate system information.
Are building footprints now in the correct location?

You have now learned to **define coordinate systems**. The most important points here are:

- You should never work with data sets that are missing a spatial reference!
- You need to know what the spatial reference is for the data set before you can use the DEFINE PROJECTION tool.
- You need to investigate the accompanying documentation or make phone calls to find out what the data set’s coordinate system really is – it has one, you just don’t know what it is.
- **Never, ever, ever, ever** use the DEFINE PROJECTION tool to define the coordinate system you would like the data set to be in if you DO NOT KNOW what it really is! What you want does not matter! You need to know what coordinate system the data set IS in. If you start guessing you can make matters much, much worse!

### Setting up for Spatial Analysis – Projecting your Data

The last important thing you need to know is that for performing spatial analysis, it is good practice to put your data frame and all the data sets that are part of the analysis into the **SAME projected coordinate system**. By spatial analysis, we mean doing queries and analysis that involve spatial relationships, like calculating area, creating buffers, select by location, and various overlay tools. If you are only mapping things, then the data sets can remain in their own coordinate systems, as long as these are all defined and the Data Frame is in the correct projection! But if you start doing spatial analysis, then it is best to make copies of these data sets that are in a shared projected coordinate system.

Let’s say that we want the Newton building footprints data layer to be part of a spatial analysis involving 3 data sets from MassGIS. **The Newton building footprints layer is in the Mass State Plane Mainland NAD 83 (feet) coordinate system, and the MassGIS data is all in Mass State Plane Mainland NAD 83 (meters).**

Let’s also assume we have decided that the **Mass State Plane Mainland NAD 83 (meters)** coordinate system is the one we will use for our project (our project is all in Massachusetts and most of our data layers come from MassGIS, so using the Mass State Plane Mainland NAD 83 (meters) is a good choice).

First, check your **Data Frame’s properties** to ensure that it is in your target coordinate system - **Mass State Plane Mainland NAD 83 (meters)**.

We are going to make a new dataset of the Newton building footprints which will be in the same coordinate system and linear units as the MassGIS data sets, by using the **Project** tool.

The **Project** tool does not convert the original coordinate system to a new one the way that DEFINE PROJECTION does – rather it makes a COPY of the original data set in a NEW projection.
To convert the Newton Building Footprints to Mass Mainland State Plane NAD 83 Meters:

1. In ArcToolbox, go to Data Management Tools \* Projections and Transformations and double-click on the Project tool as shown below:

2. Fill out the Project dialog box as you see below – note this will create a new output data set that is a copy of the Building Footprints, but in the new coordinate system you define here:

- This is the original coordinate system - ArcGIS knows this.
- You are creating a new data set - navigate to an appropriate location and give it a name.
- Pick the target coordinate system for the new data set - Projected - State Plane - NAD83 (Meters).
- Don't worry about this here - the datum of the original and target coordinate systems are the same.
3. Complete the process by clicking OK and OK – the process will take a minute. If the data set is not added automatically to the table of contents, right-click and refresh your folder in Catalog and pull in the new layer yourself.

4. Remove the older building footprint data set so you don’t get confused on which one to use in your analysis. You can do this with other data layers as well, as long as they have a correctly defined coordinate system.

**READ THE FOLLOWING!!!!!!**

**Warning:** If you incorrectly define a data layer’s coordinate system using the DEFINE PROJECTION tool, and then convert it into a different coordinate system using PROJECT, you are going to be really, really sorry, not to mention EXTREMELY confused and frustrated.

**DEFINE PROJECTION** is for defining the coordinate system of an existing data set when that data set’s coordinate system is missing. Only use this if you get a warning that a data set is MISSING A SPATIAL REFERENCE. The DEFINE PROJECTION tool does NOT make a copy of the data set – it changes the original data set!

**PROJECT** assigns a new projection to a data set in a correctly defined coordinate system. The PROJECT tool creates a new copy of the data set in the desired projection. Use this to prepare data sets for spatial analysis after you have decided on what your map projection will be for your analysis.

So be careful and always...

**Practice safe mapping – define your projection!**